
Documentation Draft – Map-Me 
 
Introduction to Map-Me 
 
Map-Me is a system for collecting ‘fuzzy’ spatial data from the public, to collect 
opinion on questions such as “where is good for…?, “where do you feel…?” or 
“where do you find…?”. The system permits you to design a survey website, which 
can collect demographic information regarding your users, and then permits them to 
answer a number of spatial questions using the “spraycan” map interface within 
Google Maps. 
 
The data that you collect will relate to a number of spatial ‘topic’ questions that 
users will answer by ‘spraying’ data onto the map, along with a number of aspatial 
questions which the user may respond to with text answers, in order to provide 
context to the patterns that they spray on the map. 
 
This document will demonstrate how to create an account with Map-Me, build your 
own Map-Me survey site, download your results, and then import those results into 
a variety of software for analysis. 
 
Creating an account 
 
In order to get started with Map-Me, the first step is to create a user account. This is 
very simple; all that is required is to go to: 
 

http://map-me.org 
 
Where you will be presented with the following form: 
 

 
 
If you have previously created an account, then you can simply log in to Map-Me 
using the “Login” form to the left. Otherwise, you can create yourself an account by 
writing your desired username into the “Username” box in the “Register” form, and 

http://map-me.org/


then adding your required password into the Password boxes and pressing 
“Register”. 
 
This will create a user account for you in Map-Me, and forward you on to the “Map-
Me Manager” which is your homepage. Here will be listed all of the sites that you 
have created, and a link allowing you to “Generate a new site”. Along with the list of 
sites, are links allowing you to edit or delete a site, and also to download various 
tables of data relating to your Map-Me sites. If you click on the name of one of your 
sites, it will take you to the site itself. 
 

 
 
Creating a site 
 
To create a site, click on the “Generate a new site” link in your “Map-Me Manager”. 
This will take you to the “Map-Me Generator”, which is the form that you fill in in 
order to create a new Map-Me site. 
 

 
 
 
The first question relates to map data: 
 

 
 
If you want to add a KML data file to your map, then click on “Browse”, and select 
the relative file. Then press “Upload KML”. This will add the file to the Google Map 
(halfway down the page), and will zoom the map to the data. 
 



You are then given the opportunity to write the “Title” for your welcome page, and 
to add some introductory text to your organisation and study. 
 

  
Following this, you have the opportunity to load an image (normally your 
organisation’s logo), which will be displayed in the “welcome” and “thank you” 
pages of your websites. Simply click on “Browse”, and select an image file for the 
image you would like to use. The image will be displayed in the dimensions and 
resolution at which it is provided, so it is simple for you to control exactly what the 
image will look like on your site, by altering the image to your exact specifications 
using image processing software such as GIMP (available at 
http://www.gimp.org/downloads/) prior to uploading. 
 

 
 
The next step is to create questions relating to the demographic information that 
you would like to collect from your users (age, sex, occupation etc.). These questions 
will be presented to the users in a form on your welcome page, and come in two 
forms, free text entry, or radio buttons. 
 
If you want to create a free text entry question, then simply enter your question, and 
leave the “Option” blank. 
 
If you would like to create a radio button question, then simply fill the question into 
the “Question” box, and then your first option into the “Option” box. You can then 
click on the “add another option” link to add as many options as you like. Note that a 
“Not Given” option will be added to the start of your form, so you do not need to 
add a ‘null’ option yourself. 
 
You can then click on the “add another question” link in order to add further 
questions (either free-text or radio button) until your demographic form is complete. 
 

http://www.gimp.org/downloads/


 
 
Next, it’s time to set up the map as you want it to look on the page in your survey. 
Simply use the Google Maps controls in order to set up the map to the location and 
zoom level that you would like it to be set at when your users see it. If you elected to 
load in a KML data file at the start of this form, then you will see that the map will 
already be set to view the loaded data. 
 
If you want to zoom to a specific place name or coordinate location, then simply type 
the name or coordinate pair into the text box immediately below the map, and click 
on “Go to Location”. 
 

 
 
Once you have set up your map, it is time to select a title and URL for your site. You 
can set the title of your site to anything that you like, but the URL name needs to be 
10 characters or less, contain no spaces, and must not have been already taken by 
any other Map-Me Site. 
 
Your URL name will be the name used in the address of the site that you are 
creating, in the form: 
 



http://map-me.org/sites/[YOUR_URL_NAME]  
 
So, for example, if you set your name to “test1”, then the web address of your site 
would be: 

 
http://map-me.org/sites/test1 

 
If you select a URL name that has been taken, then it will appear in red, available 
URL names will appear in green. It should also be noted that the address you choose 
here will not be editable in future, so choose carefully! 
 

 
 
Next it is time to set up what the spray ‘paint’ will look like when users spray it on 
the map. To do this, simply move the ‘sliders’ up and down their scales to make the 
‘blobs’ of paint larger or smaller (“Blob diameter”), and make the spread of ‘blobs’ 
larger or smaller (“Spray diameter”). 
 

 
 
Now it is time to add your questions to the site. This interface is essentially the same 
as the one used to add the demographic questions. The main difference is the 
addition of the “What colour spray?” text box. 
 
This time, your questions are divided into two sets; “Topic Questions”, which should 
be the spatial questions that users are answering by spraying on the map, and sub-
questions, which should be specific questions that the users can answer with text 
input, in order to explain and contextualise their spray patterns. 
 
First, add your topic question (e.g. “where is…?”) to the “Topic Question” text box, 
and then click in the “What colour spray?” text box and select a colour from the 
colour picker that appears. This will be the colour that the ‘paint’ is for this question 
on your site. Then you simply add your text-based “subquestions”, by filling in the 
“Subquestion” text box, and then by clicking the “add another subquestion” link to 
add as many additional subquestions as are required. It is recommended that 3 or 



fewer subquestions are used per question, though there is no limit on how many you 
can have. 
 
When you have finished adding your subquestions, click the “add another topic 
question” question to add further questions as required. Empty question or 
subquestion text boxes will be ignored by the system, though they can be removed 
with their respective “remove” links. 
 

 
 
When you have finished adding your questions, you can add a “thankyou” page 
that your users will see once they have completed the survey. As with the 
welcome page, you have the ability to add a title, and a main text entry, that may 
be used to thank your users, and perhaps to give some information regarding 
what will be done with the results of your survey. 
 

  
The last setting to determine is what will be done with the user once they leave 
your “Thankyou” page. You have the opportunity here to include a forwarding 
web address where the user will be sent to. If you leave it blank, then the user 
will be returned to the start of your site. Please note, that the full valis web 
address (starting http://… or https://) is required. 
 

  
 
Finally, when you are happy with your site, just click on the “Create Website” button. 
 



 
 
This will take you through to the “Review” page, which lists the demographic and 
survey questions that you have set in their respective colours. 
 
This page also gives you the choice to view your site, edit it, or return to your 
homepage, as well as test the address that your users will be forwarded to after they 
have completed your survey. 
 

 
 
Editing a site 
 
You may make changes to a site, including adding or removing questions by clicking 
on the “Edit” button to the right of the site name in your sites list in the “Map-Me 
Manager”, or on the link at the bottom of the review page. This will take you to the 
“Map-Me Editor”, essentially a filled in version of the “Map-Me Generator”. 
 

 
 
You can use this Editor to change any part of your site except for the URL (which 
must remain the same). If you are unhappy with your changes, you may click on the 



“Reset Values” button to return them to your saved values. When you are happy 
with your edits, click on “Update Website”. 
 

 
 
This will take you through to the “Review” page, as in the Generator, which gives you 
the choice to view your site, edit it again, or return to your homepage. 
 
Deleting a site 
 
You may delete a site by clicking on the “delete” link to the right of the site name in 
your list of sites, which will remove it from the Map-Me Manager. 
 
Analysing Results 
 
This section will walk you through how to download the data that has been 
generated within your Map-Me website. Some brief examples will then be provided 
as to how to import this data into some database, statistical, and GIS software for 
analysis. 
 
In order to be as inclusive as possible, the examples given here will relate to free, 
open-source software packages that will operate across a multitude of different 
operating systems.  
 
Downloading your results  
 
When viewing your homepage, each site listed is followed by a number of links 
(below), relating to tables of data that may be downloaded from Map-Me. 
 

 
 
These links relate to: 

 Blobs: all of the ‘blobs’ of paint that have been sprayed onto your map. 

 Users: all of the people that have viewed your site. 

 Questions: the spatial ‘topic’ questions that you set within your site. 

 Subquestions: the specific questions set for each question within your 
website. 

 Answers: the text answers that users submitted to your subquestions. 

 Dem Questions: the demographic questions that you set to be answered be 
users prior to them proceeding to your map. 

 Dem Options: the options relating to those demographic questions that you 
set that are radio buttons as opposed to text boxes. 



 Dem Answers: the answers that users submitted to your deographic 
questions. 

 User Comments: the comments users left relating to your website on the 
thankyou page (after they have finished). 

 
Each link will download all of your data in a comma separated *.CSV file, which is a 
convenient format for data to be imported into a variety of database, statistical and 
GIS software. The following sections will describe how to add these data to some 
example software, including a spreadsheet application, a database application, and a 
GIS. 
 
Introduction to LibreOffice 
 
In their own words: 
 

“LibreOffice is the power-packed free, libre and open source personal productivity 
suite for Windows, Macintosh and GNU/Linux, that gives you six feature-rich 
applications for all your document production and data processing needs.” 

 
For the purposes of analysing data from Map-Me, the Calc and Base (similar in 
functionality to Microsoft’s Excel and Access packages respectively) applications 
from within LibreOffice will be used. 
 
Further information is given at: 
 

http://www.libreoffice.org/ 
 
Downloading LibreOffice 
 
Operating system specific downloads and instructions are available at: 
  

http://www.libreoffice.org/download/ 
 
 
 
Importing in to Calc 
 
Calc is a spreadsheet application, similar to (and completely inter-operable with) 
Microsoft Excel. As such, CSV files can be opened natively. All that you need to do is 
to click on the open button: 
 

 
 
Or alternatively click on “Open” in the “File” menu. 
 

http://www.libreoffice.org/
http://www.libreoffice.org/download/


 
 
This will open a standard “Open” dialogue, simply select your file downloaded from 
Map-Me, and press “Open”.  
 

 
 
This will open the “Text Import” dialogue, which should be set up with the 
“Separated by” option selected, and the “Comma” checkbox ticked. Under “Other 
Options”, also check “Quoted field as text”, and then press “OK”. 
 

 
 
This will open the file in Calc for analysis. 
 
Importing into Base 
 



Base is a database application, similar to Microsoft Access. It is possible to load all of 
the tables downloaded from Map-Me into a database file, and perform a multitude 
of queries upon them for analysis, or to create new CSV files to be used for analysis 
in Calc, QGIS or another application. 
 
When you open Base, you are faced with the below “Database Wizard” dialog: 
 

 
 
Leave the wizard set to “Create a new database”, and Click “Next”. This will move 
you onto page 2 of the wizard. Select “Yes, register the database for me” and “Open 
the database for editing”, then press “Finish”.  
 



 
 
This will open Base with an empty database. Select “Tables” from the menu on the 
left.  
 

 
 
Base does not currently have a text import facility, so the easiest way to open your 
data in Base is to first open it in Calc as above. Once it is open in Calc, click on the tab 
(labelled “Sheet 1”) in the bottom right hand corner, and drag it into the “Tables” 
box in Base. 



 

 
 

 
 
This will open the “Copy Table” dialogue: 
 

 
 
Name the table as you would like it to be referred to by Base, and Set the option to 
“Definition and Data” and check the boxes for “Use first line as column names” and 
“Create Primary Key”. Then press Next, which will move you to the “Ad Columns” 
dialogue. 
Here, you should move all of the columns (“Column” is not part of your data) into 
the table, by selecting them and pressing the top “arrow” button. Then press “Next”. 
 



 
 
This will move you to the “Type Formatting” dialogue, where you must set the data 
type for each column.  
 

 
 



Once this is complete, click “Create”, and the table will be added to Base, as you can 
tell as it is listed in the “Tables” box. 
 

 
 
Working with data in Base 
 
Once your data is loaded into Base, all that is required is to select the “Queries” 
option to begin subsetting and joining data. 
 

 
 
There are options to create queries with a wizard or graphical designer, but it is 
recommended for full control that the SQL interface is used. In order to access this, 
simply click on the “Create Query in SQL View…” link in “Tasks”. 
 

 
 
This will open an editor from which you may type in SQL commands, and run them 
by clicking on the “Run Query” button. 
 



 
 
The results will be displayed above the query. 
 

 
 
Queries can be saved by pressing the “Save” button. 
 

 
 
Introduction to QGIS 
In their own words: 
 
“Quantum GIS (QGIS) is a user friendly Open Source Geographic Information System 
(GIS) licensed under the GNU General Public License. QGIS is an official project of the 

Open Source Geospatial Foundation (OSGeo). It runs on Linux, Unix, Mac OSX, 
Windows and Android and supports numerous vector, raster, and database formats 

and functionalities.” 
 
Further information is given at: 
 

http://www.qgis.org/ 
 

Downloading QGIS 
 
Information regarding how to download QGIS for a wide variety of operating 
systems is given here: 
 

http://hub.qgis.org/projects/quantum-gis/wiki/Download 
 
Importing into QGIS 
 
Any GIS can normally open or import a CSV file with ease, and QGIS is no different. If 
the CSV represents spatial data, there is a plugin available within QGIS that will 
handle the import for you. If the data is not spatial, then QGIS can simply open the 
table natively, by simply clicking on the “Add vector layer” button: 

http://en.wikipedia.org/wiki/GIS
http://www.gnu.org/licenses/old-licenses/lgpl-2.0.html
http://www.osgeo.org/
http://www.qgis.org/
http://hub.qgis.org/projects/quantum-gis/wiki/Download


 

 
 
Alternatively, this can be achieved by selecting “Add Vector Layer” in the “Layer” 
menu. 
 

 
 
 
This will open the “Add Vector Layer” dialogue, simply click on “Browse” in order to 
open the “Open” dialogue. 
 

 
 
In the “Open” dialogue, set the file type to “Comma Separated Value”, and select the 
file that you wish to open. Once selected, then click on “Open”. 
 

 
 



This will add the non-spatial dataset to the “Layers” list on QGIS. The data can be 
viewed by right clicking on the layer in the “Layers” list, and select “Open attribute 
table”. 
 

 
 
Activating the Plugin 
 
If you have yet to use this plugin, then the first step is to turn it on. In order to do 
this, simply go to the ‘Plugins’ menu at the top of the screen, and click on the 
‘Manage Plugins’ option. 
 

 
This will provide you with the below dialogue: 
 

 
 
And all you need to do is add click on the checkbox to the left of “Add Delimited Text 
Layer”, and then press “OK”. Once you have pressed “OK”, the dialogue will 
disappear and an icon will have been added to the toolbar. 
 

 
 
You will also notice that if you go to the “Layer” menu at the top of the screen, an 
extra option called “Add Delimited Text Layer”, with the same blue icon has been 
added. 
 



 
 
Adding your CSV data 
 
Now that this is complete, all that you need to do is click on the blue button in the 
toolbar, or on the “Add Delimited Text Layer” option in the “Layer” menu. This will 
open the below dialogue: 
 

 
 
This will initially be blank, and the first thing to do is click on “Browse” and select 
your downloaded map-me file. QGIS will then populate as many of the fields in the 
dialogue as it can, which may be adjusted by you as required: 
 

 Layer name: should contain the by which the GIS will refer to your data. 



 Select Plain Character, and set to “,”. 

 Set “Start import at row” to 0 

 Select “X Y Fields” and set “X field to “lng” and Y field to “lat”. 
 
Then press “OK”. This will open another dialog called “Coordinate Reference System 
Selector”. This should be set to WGS84, and it is likely that QGIS will set it to this for 
you. If this is the case then simply press “OK”.  
 

 
 
If the Coordinate System is not set to “WGS84”, then go to the “Search” section of 
the dialogue, and set “Authority” to “EPSG”, “Search for” to “ID” and then type 
“4326” into the text box and press “Find”. 
 

 
 
This will set the “Coordinate Reference System” to “WGS84. Then just press “OK”. 
 
Once you have pressed “OK”, then QGIS will open the layer, which should appear in 
the “Layers” list using the name that you specified. 
 



 
 
Viewing the data 
 
Now the layer is fully registered within the GIS for analysis. Right clicking on the layer 
and then clicking on “Open attribute table” will allow you to view the whole 
“Attribute table” of data.  
 

 
 
 

 
 
Alternatively, you can click on the “Identify feature” tool in the toolbar, or the 
“Identify Feature” option in the “View” menu at the top of the screen. 
 

 
 

 
 
If you then click on any one of the ‘blobs’ of data in the map window, you will be 
able to see the data associated with that particular data point. 



 

 
 
Sub-setting the data 
 
It may be the case that you only want to view some of the data that you have 
analysed. In this case, you can select the data that you are interested in by entering 
the “Attribute Table” (as above), and click on the “Advanced” button in the bottom 
right-hand of the table. 
 

 
 
This will open a dialog that will allow you to build up an SQL query in order to 
determine exactly what subset of data you would like to view. It is beyond the scope 
of this document to demonstrate SQL queries here, but an internet search will 
provide a multitude of examples and tutorials. 
 
Once selected, you can then right click on the layer in the “Layers” list, and select 
“Save selection as” if you wish to export your selection to a GIS layer for later use. 
 

 
 
Joining multiple tables of data 
 



For some more complex analyses, you may wish to join together two or more of the 
tables downloaded from Map-Me, in order, for example, to compare the answers to 
your questions that were given by a specific user, and where they sprayed. 
 
In this case, all that you need to do is right click on the layer in “Layer Control” and 
select “Properties”.  
 

 
 
This will open the “Properties” dialogue, and you should go to the “Joins” tab: 
 

 
 
Then click on the “+” button: 
 

 
 
This will open the “Add Join” dialogue: 
 

 
 



All that is required is to select the fields upon which you would like QGIS to join the 
data, and select these in Join field, and Target field. In order to assist with this, all of 
the ID’s within Map-Me data are named by the convention ‘id_[table]’, and so the 
names of corresponding fields will always match between tables. Then press “OK”, 
and “OK” again on the “Properties” dialogue. 
 
If you then open the attribute table of the table that you joined the second table to, 
then you will see that it now contains all of the fields of both tables. 
 
Creating KML data 
 
Downloading Google Earth 
 
Google Earth is a virtual globe, map and geographical information program. It is free 
to download the standard version, and it is compatible with a wide variety of 
operating systems. If you do not already have Google Earth installed on your 
machine, it can be downloaded from: 
 

http://www.google.com/earth/index.html 
 
Simply download and run the installer. 
 
Digitising KML data using Google Earth 
 
KML (Keyhole Markup Language) is the native format of Google Earth, and as such it 
is very simple to create KML data from within Google Earth. 
 
Simply navigate the map to your required location, and press one of the “digitize’ 
buttons to create either a point, line or polygon shape on the map: 
 

 
 
Simply draw the required data onto the map, and set the name and  colours / 
symbols required for your data in the “Style, Color” tab of the “Properties” window 
that opens. 
 

http://www.google.com/earth/index.html


 
 
Once you have finished, simply press “OK” and your data will appear in the “Layers” 
list to the left of the screen. 
 

 
 
 
If you want to make any adjustments to the style of your layer, simply right-click on 
it in the “Layers” list, and click on “Properties”, which will re-open the “Properties” 
dialogue. 
 



 
 
 
To export the data to a KML file, right click on the layer in the “Layers” list, and click 
on “Save Place As”. This will open a standard “Save As” dialogue, simply select the 
location and name of your file, and change the “File Type” to KML (not KMZ, which is 
the default). 
 

 
 
Click “Save”, and this will create a KML file ready to upload to Map-Me. 
 
Converting data to KML using QGIS 
 
If you already have GIS data in a different format to KML (e.g. an ESRI Shapefile, or 
MapInfo TAB), then it is simple to convert using QGIS. 
 
The first step is to load the data to QGIS, by clicking on the “Add Vector” button. 
 

 
 
This will provide you with a standard “File Open” dialogue, within which you are able 
to select your data and click “Open” to load it into QGIS. The layer will now be listed 
in the “Layers” list. 
 
All that is then required is to right-click on the layer, and click on “Save As”. 
 



 
 
This will open the “Save vector layer as…” dialogue. Set “Format” to “Keyhole 
Markup Language [KML]”, CRS to “WGS 84”, check the box next to “Skip attribute 
creation” and click on the “Browse” button for “Save as” and select the location and 
name for the KML file. Finally press “OK”. 
 

 
 
A file suitable for uploading to Map-Me will then be created. It is recommended to 
add any required styles to this file in Google Earth prior to uploading. 


